Example Workflow for a library with Millenium: using Serials SOlutions Cost Upload tool to batch apply title level cost information 
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Preparing for Cost Information Exchange
Before the initial process for the transfer of data can take place, the following needs 
to be established.
1. Determine the cost data you want to upload from your ILS (Innovative Millennium) into your ERMS (Serials Solutions 360 Resource Manager). (See Cost Management Fields)
Since our main goal for this data is to allow 360 Counter to calculate cost-per-use, we upload only basic cost data, i.e., we only upload Fiscal Year, Local System Reference ID (the order record number), Payment Type, Payee (the vendor), Fund Name, Fund Amount, Payment Amount (Local Currency), and Note (to further define what the payment covered).
2. Determine a field in your Millennium order record that you can use to enter a Serials Solutions match point that will allow for the aggregation of data from both systems.

For uploading cost information for single title journals, our match point is the “ssj number” from the MARC record that matches with the SSID number from Serials Solutions. Because we subscribe to the Serials Solutions MARC record service we are fortunate to have this stable and easy match point that already exists in corresponding Millennium records. 

3. Decide how you want to handle multiple payments for a single resource 

You must decide whether you are going to upload a payment total for each journal or if you want to load each payment separately, and if you have any exceptions to your rules. We will consolidate most all of our payments by fiscal year using an adapted template and method from Brown University. 
You must also decide how you will load payments for subscriptions that cover other serial content such as Market Share Reporter on the Gale Directory Library platform. Serials Solutions sometimes treats these as books, sometimes journals, and sometimes both. For this category, we make decisions title by title. If appropriate, check to see how previous costs have been input and follow precedent. 
4. Establish the different types of payments to track (if you want to track different types of payment).
Follow Serials Solutions procedures to set up custom payment types in the Payment Type Menu. (Answer ID: 1743)
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We have established three types of payments: Recurring—for any ongoing costs such as subscriptions, renewals, annual fees, or hosting fees, One time—for any one time cost such as purchase fees, start-up costs, archival fees, or partial payments, and Supplemental—for any costs that are in addition to the recurring costs such as price adjustments (either an increase or decrease), credits, or corrections to billing.

Step 1: Determine Which Databases Contain Your Single Title Journal Subscriptions.
This can be done in a number of ways by consulting either Millennium, Serials Solutions, or the another local source of information.   Your goal is to identify those databases that contain your single title journal subscriptions regardless of provider.  A good indicator in Serials Solutions is the number of activated Titles in the database – that is, those that are listed as “2 of 10” or “3 of 37” as opposed to “0” or “514,” or seeking out the common journal content providers such as Highwire and Metapress.
Step 2: Download “Database and Titles in Profile with Template” from Serials Solutions’ 
Cost Data Upload Tool.

Use Serials Solutions’ procedures for the Cost Data Upload tool (Answer ID 514) to download “Database and Titles in Profile with Template” for the first journal database from your list that you identified in Step 1. Save this file to your desktop and name it “EjournalTemplate.” This file will provide you with a list of all the titles you subscribe to from within that database, your match points (the SSID), and the field headers/columns for all of the possible data fields that may be uploaded into Serials Solutions.

Step 3: Use Resulting Template to Create TABLE A in Microsoft Access.
5. In Microsoft Access, open a blank database.
6. Import the template you just downloaded from Serials Solutions as a table. 
a) Go to the “External Data” tab.
b) From “Import & Link” options, select “Text File.”
c) Select “Import the source data into a new table in the current database” and browse to find your saved .txt file.
d) Select “Delimited” and click on “Next”.
e) Set delimiter as “Tab” and Text Qualifier as “[double quote]” and check the box that says “First Row Contains Field Names”. Click on “Next”.
f) Leave defaults and click “Next”.
g) Choose “No primary key” and click on “Next”.
7. Under “Import to Table”, name file “EJournal Cost Template” and click on “Finish”.
Step 4: Add Remainder of Your Journal Titles to TABLE A.
1. Return to Serials Solutions Cost Data Upload tool and download “Database and Titles in Profile with Template” for the next journal database from your list that you identified in Step 1. Save the file to your desktop and name it “EjournalTemplate.”overwriting the file you created in Step 2. 
2. Add these additional titles to TABLE A (EJournal Cost Template), by “appending” the table.

a) Go to the “External Data” tab.
b) From “Import & Link” options, select “Text File.”
c) Select “Append a copy of the records to the table [Ejournal Cost Template] and browse to find your saved .txt file.
d) Select “Delimited” and click on “Next”.
e) Set delimiter as “Tab” and Text Qualifier as “[double quote]” and check the box that says “First Row Contains Field Names”. Click on “Next”.
f) “Import to Table” [Ejournal Cost Template] and click on “Finish”.
g) [OPTIONAL] You may choose to “Save import steps” to create a macro to automate this procedure (steps a-f) as you repeat it for each of your additional journal databases. To then run the macro for your next batch of titles, make sure you close the table and then go to the “External Data” tab, this time choosing “Save Imports” from the “Import & Link” options. After you “Run” it, you should get a “All objects were imported successfully” note.
Repeat Step 4 for each of your journal databases.
Step 5: Use Innovative’s Create Lists to Identify and Export Journal Cost Information
1. First, identify your single title e-journal subscriptions included in your order records— consider fund codes, locations, statuses, etc.
2. With your list highlighted, click “Export Records”. Choose the fields you want to export, click “Browse” to choose your desktop as the destination for your file, and click “OK” to save your resulting .txt file. Here is an example of one library’s chosen fields to get their journal payment records:
a. Line 1: Type = “BIBLIOGRAPHIC”  Field = “MARC Tag <insert text>245”
b. Line 1: Type = “BIBLIOGRAPHIC”  Field = “MARC Tag <insert text>001”
c. Line 2: Type = “ORDER”   Field = “RECORD #”
d. Line 5: Type = “ORDER”   Field = “VENDOR”
e. Line 6: Type = “ORDER”   Field = “FUND”
f. Line 7: Type = “ORDER”   Field = “PAID”
i. Check box for “Limit payments to a time period”
ii. Choose “Paid Date”
iii. Define Start Date and End Date by fiscal year.
(07-07-20xx to 06-30-20xx)
Step 6: Revise and Winnow Cost Information from Millennium Create List.
8. Using Excel, open the .txt file containing the cost information you exported from Millennium at the end of Step 5. File>Open>[file name]>Delimited>Next>Delimiters=Comma and Semicolon>Next>Finish
9. Scan spreadsheet for empty cells and other oddities and delete/correct. 
10. In the spreadsheet, resolve any multiple payments showing on a single row for a resource using the multiple-payment calculation template found in DeptStore.
a. Copy the data from the Excel file and copy into row 6 of the “orig output” tab in the template.
b. Highlight columns I, R, AA, AJ, and AS, and make sure they include cost information.
c. Scan to see if you have any journals with more than 5 payments. If so, note that you must manually enter cost data and delete from spreadsheet, as the template can only accommodate the first five.
d. Click on “calculation-template” tab to see consolidation of payments. Delete place holder data (rows 2-6) and copy the portion of the template with values (and not the number of payments) and "paste-special-values" onto a blank sheet to get the final list of cost data.
11. Consulting the Serials Solutions template you turned into TABLE A in Step 3, re-label the column headers in your Millennium spreadsheet to exactly match the field names from the Serials Solutions Template. For example:
	Existing Millennium Template Header
	…Becomes

	245/Title
	Title Name

	001
	SSID

	RECORD #(ORDER)
	Local System Reference ID

	VENDOR
	Payee

	FUND
	Fund Name

	Amount Paid
	Payment Amount (Local Currency)

	Note
	Note


(If your # of Payments column has been transferred to the final spreadsheet delete.)
12. In your Millennium spreadsheet, add a column next to the “Fund Name” column and label it “Fund Amount”. Copy and paste the data from the “Payment Amount (Local Currency)” column, so that this data will also populate into the Fund Amount Field.
Screen shot: Serials Solutions Fund Name Manager 
13. In your Millennium spreadsheet, label an additional column “Fiscal Year”. (This will be populated later.)
14. While you are in the final pasted sheet, use Save As to rename the file “EJournal Cost Info” and save as a Tab Delimited .txt file to save this one sheet. (Be careful not to overwrite the template.)
Step 7: Use Resulting Spreadsheet to Create TABLE B in Microsoft Access.

15. Open your Microsoft Access database from Step 3 and create a new table.
16. Import the .txt file you just created (“EJournal Cost Info”). 
a. Go to the “External Data” tab.
b. From “Import & Link” options, select “Text File.”
c. Select “Import the source data into a new table in the current database” and browse to find your saved .txt file.
d. Select “Delimited” and click on “Next”.
e. Set delimiters as “Tab” and Text Qualifier as “[double quote]” and check the box that says “First Row Contains Field Names”. Click on “Next”.
f. Leave defaults and click “Next”.
g. Chose “No primary key” and click on “Next”.
h. Under “Import to Table”, name file “EJournal Cost Info” and click on “Finish”.
Step 8: Create a QUERY in Microsoft Access to combine EJournal Title data from TABLE A and cost information from TABLE B. Rename headers to match the Serials Solutions Template.

17. Design a QUERY that includes both TABLES – the EJournal Cost Template and EJournal Cost Info – and use the SSID as a match point by clicking on SSID and dragging it to SSID in the other table or via Join Properties. 
18. Select the fields you want to upload from each table. 
	From “EJournal Cost Info”
	From “EJournal Cost Template”

	Local System Reference ID

Payee

Fund Name

Fund Amount

Payment Amount (Local Currency)

Note

Fiscal Year
	Database Name

Database Code

Title Name

Title Id

ISSN

SSID

Include in Total for Year


19. From the File menu, Save the query as “EJournal Costs for Uploading”.
Step 9: Populate “Fiscal Year” and “Include in Total for Year” fields.
1. Create and Run an UPDATE QUERY in Microsoft Access that will populate your Fiscal Year field with the year that matches the cost information in your table and that will check the box for Include in Total for Year.
a. From the Design View, select Update and key in the year in the “Update to” row under the Fiscal Year column, and a “T” in the Include in Total for Year column.
b. Select “Run” and say yes to the number of rows its wants to update.

c. Select “Select” to again show all of your data fields.

d. Return to normal view to verify your fields have been updated appropriately.

2. Export the contents of your query (EJournal Costs for Uploading). Save as a tab delimited text file on your desktop.  External Data>Export>.txt File
a. Go to the “External Data” tab.
b. From “Export” options, select “Text File.”
c. Make no selections and Browse to your desktop to save the file. Click “OK.”
d. Select “Delimited” and click on “Next”.
e. Set delimiters as “Tab” and Text Qualifier as “[double quote]” and check the box that says “First Row Contains Field Names”. Click on “Next”.
f. Under “Export to File”, name file “EJournal Costs for Uploading” and click on “Finish”.
Step 10: Upload into Serials Solutions 360 Resource Manager using the Cost Data Upload tool.

20. Log into Serials Solutions and go to the Cost Data Upload feature.
21. Browse to the tab delimited text file on your desktop.

22. Upload the file. Watch for confirmation of successful upload.

23. Check for errors. Locate the matching file name and time stamp for your upload from the drop down menu and click “Get Status.”

24. Resolve any load errors manually and do not upload file again because duplicate cost information could be created and is not easily corrected.

Step 11: Resolve and Manually Upload Cost Information for Titles That Were Not Matched in Your Query.

Compare the number of records in the Cost Info Table with the number in your final query results to see where matches did not occur. This may happen because cost information may have been attached to bib records without SSIDs (the match point), the titles may have changed or have been turned off in the knowledge base, etc. 
NOTE: Procedures for database costs have a separate set of procedures.
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